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AN75320 向您介绍了 PSoC® 1，它是一个带有可编程数字和模拟模块的 8 位处理器，能够实现自定义功能。该应用笔记

说明了 PSoC 1 架构和开发工具，并介绍如何创建您的第一个设计。此外，本应用笔记还向您提供了更多的资源，用以

加快深入学习有关 PSoC 1 的知识。 
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1 简介 

PSoC 1 是真正的可编程嵌入式片上系统，在同一芯片中集成了自定义的模拟和数字外设功能、存储器以及 M8C 微控制

器。这样的系统和大部分混合信号嵌入式系统不完全一样，其它嵌入式系统使用了一个微控制器（MCU）和外部模拟和

数字外设的组合。除 MCU 外，通常这种类型的系统还需要多个集成电路，如运算放大器、模数转换器（ADC）和数字

ASIC。 

PSoC 1 提供了 MCU 加外部集成电路（IC）组合的替代方案。它的可编程模拟和数字子系统不仅可以降低整个系统成本，

而且还支持极为灵活地调整设计，使产品快速上市。 

PSoC 1 的系统资源可以在运行时动态重新配置，以执行完全不同的功能。在设计资源已被占用的实例中，可以执行动

态重配置。这样，您能够重复使用 PSoC 1 系统资源并最大化集成价值主张。 

PSoC 1 中的电容式触摸感应特性，称为 CapSense®，能提供前所未有的信噪比（SNR）、一流的防水性能以及支持各

种类型的传感器，如按键、滑条、触控板和接近传感器。 

本应用笔记帮助您了解 PSoC 1 架构及各种开发工具，并且它也展示了如何使用 PSoC Designer™（即为 PSoC 1 的开

发工具）来构建您的第一个项目。此外，本应用笔记还向您提供了更多的资源，用以加快深入学习有关 PSoC 1 的知识。 

除 PSoC 1 外，赛普拉斯 PSoC 系列还包括 PSoC 3、PSoC 4 和 PSoC 5LP 器件。这些 PSoC 器件提供了不同的系统

架构和外设。更多有关信息，请参见赛普拉斯平台 PSoC 解决方案蓝图。 

2 入门 

在赛普拉斯网站 www.cypress.com 上提供了大量数据，有助您正确选择 PSoC 器件来进行设计，从而使您能够快速并

有效地将器件集成到设计中。有关资源的完整列表，请参考知识库文章如何使用 PSoC® 1、PowerPSoC®和 PLC 进行

设计 — KBA88292。下面是 PSoC 1 的简要列表： 

▪ 概述：PSoC 产品系列、PSoC 蓝图 

▪ 产品选型器：PSoC 1、PSoC 3、PSoC 4、PSoC 5LP 

▪ 此外，PSoC Designer 还包含了一个器件选择工具。 

▪ 应用笔记：赛普拉斯提供了大量 PSoC 应用笔记，包括了从基础到高级的广泛内容。下面列出了 PSoC 1 入门的应

用笔记： 

 AN75320 —PSoC® 1 入门。 

 AN2094 — PSoC® 1 GPIO 入门。 

 AN74170 — PSoC® 1 模拟结构和通过 PSoC Designer™进行的配置  

 AN2041 — 了解 PSoC® 1 开关电容模拟模块 

 AN2219 — PSoC® 1 选择模拟接地和参考 

注意：欲了解与 CY8C29X66 器件相关的应用笔记，请点击此处。 

▪ 开发套件： 

 除了 CY8C25/26xxx 器件外，CY3210-PSoCEval1 支持所有 PSoC 1 混合信号阵列系列（包括汽车级器件）。

该套件包括 LCD 模块、电位器、LED 和实验板空间。 

 CY3214-PSoCEvalUSB 主要作为 CY8C24x94 PSoC 器件的开发板使用。开发板的特殊功能包括 USB 和

CapSense 开发和调试支持。 

注意：欲了解与 CY8C29X66 器件相关的开发套件，请点击此处。 

MiniProg1 和 MiniProg3 提供了用于闪存编程和调试的接口。 

 

 

http://www.cypress.com/
http://www.cypress.com/?rID=86788&source=an79953
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http://www.cypress.com/?id=4976&source=PSoC3_Datasheet
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http://www.cypress.com/documentation/application-notes/an2094-psoc-1-getting-started-gpio
http://www.cypress.com/documentation/application-notes/an74170-psoc-1-analog-structure-and-configuration-psoc-designer
http://www.cypress.com/documentation/application-notes/an2041-understanding-psoc-1-switched-capacitor-analog-blocks
http://www.cypress.com/documentation/application-notes/an2219-psoc-1-selecting-analog-ground-and-reference
http://www.cypress.com/?id=1368&rtID=76
http://www.cypress.com/?rID=2541
http://www.cypress.com/?rID=37815
http://www.cypress.com/?rID=63754
http://www.cypress.com/?rID=37459
http://www.cypress.com/?rID=38154
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2.1 PSoC Designer 

PSoC Designer 是基于 Windows 的免费集成设计环境（IDE）。在拖放式设计环境中使用预先设定的模拟和数字外设库

来开发您的应用。然后，利用动态生成的 API 代码库来自定义您的设计。图 1 显示的是 PSoC Designer 窗口。注意：这

并不是默认窗口。 

1. Global Resources（全局资源） — 所有的器件硬件设置。  

2. Parameters（参数）— 当前选中的用户模块的参数。 

3. Pinout（引脚分配） — 器件引脚的相关信息。  

4. Chip-Level Editor（芯片级编辑器）— 选中芯片上可用资源的框图。 

5. Datasheet（数据手册） — 当前选中的用户模块的数据手册。 

6. User Modules（用户模块） — 选中器件的所有可用的用户模块。 

7. Device Resource Meter（器件资源计） — 当前项目配置的器件资源使用率。 

8. Workspace（工作区） — 与项目有关的文件树级图 

9. Output（输出） — 项目的编译和调试输出。 

注意：欲了解有关 PSoC Designer 的详细信息，请打开 PSoC Designer IDE、转到 Help > Documentation、打开

“Designer Specific Documents”文件夹，然后打开“IDE User Guide.pdf”文档。 

图 1. PSoC Designer 布局 

 

 

  

http://www.cypress.com/
http://www.cypress.com/?id=2522
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2.2 代码示例 

下面的网页列出了基于 PSoC Designer 的代码示例。这些代码示例通过向您提供一个完整的设计（而不是空白设计）加

快您的设计过程，并显示了如何将 PSoC Designer 用户模块用于各种应用。 

http://www.cypress.com/documentation/code-examples/psoc-1-code-examples 

要想访问集成在PSoC Designer中的代码示例，请依次选择Start Page > Design Catalog > Launch Example Browser，

如图 2 所示。 

图 2. PSoC Designer 中的代码示例 

 

 

在图 3 中显示的示例项目浏览器内，您可以选择以下选项。 

▪ 关键词搜索，用于筛选项目。 

▪ 根据类别列出项目 

▪ （在 Description 选项卡上）查看已选项目的数据手册。 

▪ 查看已选项目的代码示例。您可以复制该窗口中的代码然后将其粘贴到您的项目内，从而加快代码的开发项目，或 

▪ 根据已选项目创建一个新的项目（若需要可添加新的工作区）。通过为您提供一个完整的基本设计，它可以加快您

的设计过程。然后，您可以根据自己的应用更改该设计。 

http://www.cypress.com/
http://www.cypress.com/documentation/code-examples/psoc-1-code-examples
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图 3. 带有样例代码的代码示例项目 

 

2.3 PSoC Designer 帮助 

请访问 PSoC Designer 主页以下载 PSoC Designer 的最新版本。然后，启动 PSoC Designer 并导航到以下各项： 

▪ IDE 用户指南：依次选择 Help > Documentation > Designer Specific Documents > IDE User Guide.pdf 。本指

南提供了开发 PSoC Creator 项目的基本知识。 

▪ 简单用户模块代码示例：依次选择 Start Page > Design Catalog > Launch Example Browser。这些代码示例显

示了如何配置和使用 PSoC Designer 用户模块。 

▪ 技术参考手册：依次选择 Help > Documentation > Technical Reference Manuals。该指南列出并描述了 PSoC 1

器件的系统功能。 

▪ 用户模块数据手册：右击用户模块并选择“Datasheet”。该数据手册说明了已选用户模块中的各参数和 API。 

▪ 器件数据手册：依次选择 Help > Documentation > Device Datasheets，从而获得特殊 PSoC 1 器件的数据手册。 

▪ Imagecraft 编译器指南：依次选择 Help > Documentation > Compiler and Programming Documents > C 

Language Compiler User Guide.pdf 。该指南提供了 Imagecraft 编译器特殊指令和函数的详细信息。 

2.4 技术支持 

若有任何疑问，我们的技术支持团队很乐意为您提供帮助。您可以在赛普拉斯技术支持页面上创建一项支持请求。 

如果您在美国，可以通过拨打我们的免费电话，直接与技术支持团队联系：+1-800-541-4736。在提示符处选择第 8 项。 

 

若想快速获得支持，您同样可以使用下面的支持资源。 

▪ 自助 

▪ 所在地销售办事处 

http://www.cypress.com/
http://www.cypress.com/products/psoc-designer
https://secure.cypress.com/myaccount/?id=25&techSupport=1&source=an79953
http://www.cypress.com/?id=4
http://www.cypress.com/?id=1062
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3 PSoC 1 系列的比较 

PSoC 1 包括 13 个器件系列。表 1 显示的是这些器件具有的特性。 

表 1. PSoC 1 器件选型汇总表

特性 

器件系列 

29x66 28xxx 27x43 24x94 24x93 24x33 24x23A 23x33 22x45 21x45 21x34 21x23 

闪存 

（KB） 
32K 16K 16K 16K 32K 8K 4K 8K 16K 8K 8K 4K 

SRAM 

（KB） 
2K 1K 256B 512B 2K 256B 256B 256B 1K 512B 512B 256B 

ADC 1 

（DS/SS） 

14 位 

（DS） 

4x14 位

（DS） 

11 位 

（DS） 

14 位

（DS） 

10 位 

（INC） 

11 位 

（DS） 

11 位 

（DS） 

11 位

（DS） 

8 位 

（SS） 

8 位 

（SS） 

10 位 

（SS） 

10 位

（SS） 

ADC 2 

（SAR） 
- 

10 位 

（150  

Ksps） 

- - - 

8 位 

（300 

 Ksps） 

- 

8 位 

（300 

Ksps） 

10 位 

（150 

Ksps） 

10 位 

（150  

Ksps） 

- - 

电压比较器 4 4 4 2 2 2 2 2 4 4 2 2 

DAC  

（8 位） 
4 4 4 2 - 2 2 2 - - - - 

PGA  

（x48 增益） 
4 4 4 2 - 2 2 2 - - - - 

TCPWM 

（16 位） 
8 6 4 2 

3 

（定时器） 
2 2 2 4 2 2 2 

UART/SPI 4 3 2 1 1 SPI 1 1 1 2 1 1 1 

I2C 1 2 1 1 
1 

（从设备） 
1 1 1 1 1 1 1 

CapSense

按键 
- 43 - 49 - - - - 37 23 23 - 

GPIO 64 44 44 50 36 26 24 26 38 24 24 16 

USB - - - FS 2.0 FS 2.0 - - - - - - - 

ECO 支持 支持 支持 不支持 支持 支持 支持 支持 支持 支持 不支持 不支持 

SMP 支持 支持 支持 不支持 不支持 不支持 支持 不支持 支持 支持 支持 支持 

MAC 2 2 1 2 0 1 1 1 1 1 0 0 

FS = 全速、SMP = 开关电压泵、ECO = 外部晶体振荡器、MAC = 乘法累加器、 INC = 递增、DS = 双斜率、SS = 单斜率、PGA = 可编程增益放大器、TCPWM = 定时器计数器脉冲宽度调制器、

UART = 通用异步接收器/发送器、SPI = 串行外设接口、I2C = 内部集成电路 

    

 
 
 
 
 

 
 
 
 

http://www.cypress.com/
http://www.google.co.in/url?sa=t&rct=j&q=&esrc=s&source=web&cd=7&ved=0CEUQFjAG&url=http%3A%2F%2Fwww.embedded.com%2Felectronics-blogs%2Fbeginner-s-corner%2F4023908%2FIntroduction-to-Serial-Peripheral-Interface&ei=rkM-U43SK4X3rQfFhoAY&usg=AFQjCNEtX3Xm4fd8n8eB_cskEKf0dsqKdw&bvm=bv.64125504,d.bmk
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4 PSoC 1 特性集 

PSoC 1 具有一系列强大的功能和特性，包括：一个 CPU 内核和存储器子系统、一个数字子系统、一个模拟子系统、一

个存储器系统以及系统资源，如图 4 所示。下面各节对每个特性进行了简要说明。更多有关信息，请查看 PSoC 1 的参

考资源一节中所列出的 PSoC 1 系列器件的数据手册、技术参考手册（TRM）以及应用笔记。 

图 4. PSoC 1 架构（CY8C29466） 
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图 4 显示的是 CY8C29466 器件系列的各项特性。对于其他器件系列具备的这些特性的子集，请参考表 1。  

http://www.cypress.com/
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4.1 M8C 处理器和储存器 

PSoC 1 具有一个 M8C 处理器，该处理器是一个带有 Harvard 架构的 8 位 RISC CPU。它的最大工作频率为 24 MHz，

并提供了 4 MIPS 的性能。M8C 具有 37 条指令。PSoC 1 器件具有 2 KB 的 SRAM 和 32 KB 的闪存，如表 1 所示。有

关详细信息，请参见 PSoC 1 技术参考手册。 

4.2 可编程数字子系统 

PSoC 的数字子系统是独一无二的，因为它具有性能优异的可编程性和灵活的路由系统。表 1 列出了每个器件可用的各

种 PSoC 1 器件以及数字资源。PSoC 1 中的数字模块分为两种类型：数字基本模块（DBB）和数字通信模块（DCB）。

DBB 和 DCB 的数量始终是相等的。  

4.2.1 数字基本模块（DBB）  

DBB 是可配置的基本数字资源，您可将其配置为定时器、计数器或脉冲宽度调制器（PWM）。每个 DBB 中均可放置一

个 8 位的数字资源。创建 16 位、24 位或 32 位数字资源分别需要 2 个、3 个或 4 个数字模块。  

4.2.2 数字通信模块（DCB）  

DCB 不仅能够放置基本数字资源（定时器、计数器或 PWM），还可以用来放置数字通信资源，例如 SPI 和 UART。您

也可以在 DCB 中放置 DBB。不过，您不能将 DCB 资源放置于 DBB。 

4.3 可编程模拟子系统 

PSoC 1 的独特模拟子系统由采用列配置分布的模拟模块组成。这些模拟模块均为连续时间（CT）模块或开关式电容（SC）

模块。 

4.3.1 连续时间（CT）模块  

PSoC 内部的连续时间（CT）模块是可编程模拟模块，用户可将其配置为比较器或可编程增益放大器（PGA）。CT 模

块围绕着低噪声和低偏移的运算放大器来构建。CT 模块中的大多数模拟复用器提供了高度可配置性。有关连续时间模

块结构和组成的更多信息，请参阅 PSoC 1 技术参考手册的第 22 章。 

4.3.2 开关式电容（SC）模块  

SC 模块围绕着低噪声和低偏移的运算放大器来构建，并被多个模拟复用器环绕。这些模块极为特别，因为其周围的运

算放大器和复用器均是电容组和开关组。与 CT 模块不同，开关式电容模块中没有电阻阵列。有关 SC 模块结构的更多

信息，请参阅 PSoC 1 技术参考手册的第 23 章或 AN2041 — 了解 PSoC 1 开关电容模拟模块。 

4.4 系统范围资源 

4.4.1 时钟系统  

PSoC 具有一个高级的时钟系统，系统含有多个时钟源，许多时钟源均可进行编程。从内部 24 MHz 主振荡器（IMO）

或最高 24 MHz 的外部时钟中提取主时钟源。此外，对于低速振荡器，可以使用 32 kHz 的外部振荡器电路或内部低速振

荡器（ILO）。有关 PSoC 1 可用时钟的详细信息，请参考 AN32200 — PSoC® 1 — 时钟和全局资源。 

4 .4 .2 开关电压泵（SMP）  

开关电压泵（SMP）是一种受 PSoC 支持的 DC/DC 升压电路，通过它，器件将可以由单节 1.5 V 电池供电运转。PSoC

含有一个内置的 FET 和独立的 PWM 硬件，以实现升压。您只需提供一节外部电池、一个电感、一只二极管和一个电容

便完成升压电路。更多详细信息，请参考 PSoC 1 技术参考手册中第 30 章的内容。 

 

4.4.3 乘法累加器（MAC）  

乘法累加器，即 MAC，能够提供一个 8 位有符号数乘数器，以及用于对数字求和的 32 位累加器。在进行数学运算和实

现数字滤波器时，MAC 极为有用。您可以通过向器件中的特定寄存器写入或读取数据来使用 MAC。在完成乘运算后，

您可以从寄存器中读出数值或将值存储在累加器中。通过向清零寄存器（MACx_CL1 和 MACx_CL2）写数据，可以清

空累加器并将其复位至零。更多详细信息，请参考 PSoC 1 技术参考手册中第 26 章的内容。 

4.4.4 电压参考  

PSoC 1 中有许多参考电压的选项。其中最重要的三个术语分别为： 

http://www.cypress.com/
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1278&f%5b2%5d=resource_meta_type%3A583
http://www.cypress.com/documentation/technical-reference-manuals/cy8cplc20-cy8cled16p01-cy8c29x66-cy8c27x43-cy8c24x94?source=search&cat=technical_documents
http://www.cypress.com/documentation/technical-reference-manuals/cy8cplc20-cy8cled16p01-cy8c29x66-cy8c27x43-cy8c24x94?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an2041-understanding-psoc-1-switched-capacitor-analog-blocks
http://www.cypress.com/?rID=2773
http://www.cypress.com/documentation/technical-reference-manuals/cy8cplc20-cy8cled16p01-cy8c29x66-cy8c27x43-cy8c24x94?source=search&cat=technical_documents
http://www.cypress.com/documentation/technical-reference-manuals/cy8cplc20-cy8cled16p01-cy8c29x66-cy8c27x43-cy8c24x94?source=search&cat=technical_documents
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1. AGND    

2. RefHi  

3. RefLo 

器件中模拟信号的电压均以模拟地（AGND）为参考地。AGND 的电压值有多种选项，具体数值由开发人员决定。高于

AGND 的模拟信号被视为正，而低于 AGND 的电压则被视为负。RefHi 和 RefLo 指模拟系统的电压上限和下限。更多详

细信息，请查看 AN2219 — PSoC® 1 选择模拟接地和参考。 

4.4.5 I 2 C 专用硬件  

I2C 通信模块是一种串行转并行的处理器，用于将 PSoC 器件连接至 I2C 两线串行通信总线。为消除的 M8C 微控制器过

多干预和开销，该硬件控制器支持针对 I2C 的状态检测和分割位生成功能。  

以下为 PSoC I2C 硬件控制器的主要特性和功能： 

▪ 行业标准 Philips® I2C 总线兼容接口 

▪ 主设备和从设备操作，可实现多主设备操作 

▪ 只有两个引脚（SDA 和 SCL）需要与 I2C 总线连接 

▪ 标准数据速率为 100/400 kbps，同时支持 50 kbps 

▪ 7 位寻址模式，支持 10 位寻址 

有关使用 I2C 的更多信息，请参见 AN50987：PSoC 1 I2C 入门。 

4.5 GPIO 系统 

GPIO系统提供了CPU与外设以及外界相互间的接口。在用作数字 I/O时，每个GPIO可以支持 10 mA的拉电流和 25 mA

的灌电流。器件总共可以支持 200 mA 的灌电流，每侧 100 mA。因此，任意端口上的偶数引脚都能够支持共计 100 mA

的灌电流，所有奇数引脚也可以支持 100 mA 的灌电流。此外，器件可以支持共计 80 mA 的拉电流，每侧 40 mA。更多

详细信息，请参见 PSoC 1 技术参考手册和 AN2094 — PSoC® 1 GPIO 入门。 

4.6 CapSense 

某些 PSoC 1 器件还支持一种电容式触摸传感方法，即为 CapSense。电容式触摸传感器是用户接口设备，通过检测人

体的电容变化可检测（接近）传感器周围是否存在手指。电容式传感器有出色的外观，容易使用且使用寿命长。使用

CapSense，您可以利用作为 PCB 上简单铜走线的电容式感应按键替代价格昂贵但性能却不可靠的机械按键。CapSense

支持各种传感器，如：按键、滑条、触摸板以及接近传感器。请参考表 1 以了解支持 CapSense 的 PSoC 1 器件。更多

详细信息，请参见 AN64846 — CapSense 入门。  

 

4.7 动态重配置 

对于 PSoC 1，用户可以直接开始设计，而无需要先了解终端产品，然后根据需要添加资源。只要用户有可用的数字或

模拟资源，便可以随时对设计进行调整、修改和扩展。即使在设计中资源已被占用，PSoC 也可在运行时进行动态重配

置，以实现其他功能。这使您能够重复使用 PSoC 中的资源并最大化集成价值主张。更多详细信息，请参考 AN2104 — 

PSoC®1 — 使用 PSoC® Designer™进行动态重配置。 

5 开发工具 

赛普拉斯为 PSoC 1 提供了高质量的开发工具，如 PSoC Designer 软件工具和包含开发套件、编程硬件、调试硬件的硬

件工具。使用这些工具，用户便可以配置器件、开发应用代码、构建、调试并实施嵌入式设计。 

5.1 软件：PSoC Designer 集成开发环境 

赛普拉斯 PSoC Designer 是一个集成开发环境（ IDE），用于自定义、配置和编程 PSoC 1 器件。您可以从

http://www.cypress.com/products/psoc-designer 网站下载该工具。  

PSoC Designer 开发环境功能齐全，您可以在其中配置模拟和数字外设、编写应用代码，并执行本应用笔记中所述的功

能，从而创建您自己的 PSoC 应用。此外，您可使用本软件在 PSoC ICE-Cube 调试平台对 PSoC 器件进行编程和调试。 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an2219-psoc-1-selecting-analog-ground-and-reference
http://www.cypress.com/?rID=34486
http://www.cypress.com/documentation/technical-reference-manuals/cy8cplc20-cy8cled16p01-cy8c29x66-cy8c27x43-cy8c24x94?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an2094-psoc-1-getting-started-gpio
http://www.cypress.com/documentation/application-notes/an64846-getting-started-capsense?source=search&keywords=getting%20started%20with%20capsense
http://www.cypress.com/?rID=2901
http://www.cypress.com/?rID=2901
http://www.cypress.com/products/psoc-designer
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图 5 显示了 PSoC Designer 的布局，并且 PSoC Designer 一节对 IDE 的各个部分进行了描述。请注意，这并不是

PSoC Designer 的默认布局。如果以下描述的任何窗口在您打开 Designer 时并未出现，均可在工具栏中的 View（查看）

下拉菜单中进行添加。 

图 5. PSoC Designer 布局 

 

5.2 硬件 

赛普拉斯提供了各种 PSoC 1 硬件套件，以满足您的设计要求。要想选择您的 PSoC 1 器件，请参考 PSoC 1 套件和

PSoC 1 套件选择器指南中介绍的内容。以下部分将会提供开发套件、编程硬件和调试硬件的列表。  

 

5.2.1 开发套件  

通过赛普拉斯的开发工具，您可轻松构建自己的 PSoC 1 设计原型。表 2 列出了一些支持 PSoC 1 评估的开发套件。 有

关开发套件/开发板的完整列表，请参阅开发套件内容。 

表 2. PSoC 1 开发套件 

开发套件 说明 

CY3210-PSOCEVAL1  
通过 CY3210 PSoC Eval1 套件，您可以评估和体验赛普拉斯 PSoC 1 可编程片上系统的设计

方法和架构 

CY8CKIT-001 
CY8CKIT-001 PSoC 开发套件提供一个通用的开发平台，以供用户实现和评估不同的解决方案

原型。 

5.2.2 硬件编程器  

您可以从赛普拉斯所提供的工具以及第三方工具为编程器件选择一些选项。赛普拉斯提供了四种编程器件：MiniProg1、

MiniProg3、ICE-Cube 和 CY3207-ISSP。 

 MiniProg1 

MiniProg1 是 ISSP 编程器，许多 PSoC 1 开发套件均包含该编程器。除 CY25/26xxx 器件以外，其他的 PSoC 1 器件均

可使用该编程器。不能使用 MiniProg1 来编程 PSoC 3 或 PSoC 5 器件。 

http://www.cypress.com/
http://www.cypress.com/?rID=63754
http://www.cypress.com/?docID=36495
http://www.cypress.com/documentation/development-kitsboards/psoc-1-kits#res577
http://www.cypress.com/?rID=2541
http://www.cypress.com/?rID=37464
http://www.cypress.com/?rID=37459
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 MiniProg3 

MiniProg3 是 ISSP 编程器，包含在 CY8CKIT-001 开发套件中。MiniProg3 是 PSoC 1、PSoC 3 和 PSoC 5 器件的一体

化编程器，也是PSoC 3和PSoC 5架构的调试工具，同时也是用于调试 I2C串行连接和与PSoC器件进行通信的USB-I2C

桥接器。 

 第三方编程器 

请访问网站 http://www.cypress.com/documentation/development-kitsboards/general-psoc-programming 查阅第三方编

程器列表。这些工具均由赛普拉斯设计、测试和认证，用于支持 PSoC 1 器件的编程。  

5.2.3 调试硬件  

 CY3215A-DK  

CY3215A-DK 在线仿真器 Lite 开发套件包括一个在线仿真器（ICE）。ICE-Cube 主要用于调试 PSoC 1 器件，但它也

可使用 ISSP 编程 PSoC 1 器件。您可以直接使用 ISSP 黄色线缆编程器件，而无需用 CAT5 蓝色线缆或柔性线缆与调试

转接板连接。因此，在调试和生产环境中，ICE-Cube 均适用。更多详细信息，请查看 AN73212 — 使用 PSoC 1 进行

调试。 

6 PSoC 1 的参考资源 

本节提供了 PSoC 1 学习资源列表，以帮助您入门并使用 PSoC 1 开发完整的应用。 PSoC 1 开发人员可以使用许多资

源，包括数据表、参考手册、视频以及应用笔记。 

6.1 PSoC 1 数据手册 

请访问 PSoC 1 数据手册网页以查看 PSoC 1 数据手册，该数据手册将列出所有 PSoC 1 器件系列中的各项特性以及电

气规范。 

6.2 学习 PSoC 1 Designer 

请访问 PSoC Designer 主页以下载 PSoC Designer 的最新版本。 

启动 PSoC Designer，然后逐步执行以下各项： 

PSoC Designer 用户指南：访问 PSoC Designer 用户指南网页以便查看 PSoC Designer 用户指南。 

6.2.1 IDE 用户指南：  

启动 PSoC Designer > Help > Documentation > Designer Specific Documents > IDE User Guide。本指南提供了

开发 PSoC Designer 项目的基本知识。 

6.2.2 示例项目：  

启动 PSoC Designer > Design Catalog > Example projects。这些示例项目展示了如何配置及使用 PSoC Designer

组件。 

6.2.3 PSoC Designer 培训   

这些培训将帮助您设计和展示介绍 PSoC Designer、动态重配置以及使用 PSoC 进行调试。 

6.2.4 组件数据表：  

启动 PSoC Designer > Workspace Explorer。在 Chip 选项卡下面，右击某个组件并选择 Datasheet（数据手册）。 

6.3 应用笔记 

通过各应用笔记，您可以了解器件的具体功能并设计您的 PSoC 1 应用。请访问 PSoC 1 应用笔记网页以获取 PSoC 1

应用笔记的完成列表。 

6.4 知识库文章 

这是包含了常见技术支持问题及其相关解答的数据库。请访问知识库文章网页以获取 PSoC 1 知识库网页的完整列表。 

http://www.cypress.com/
http://www.cypress.com/?rID=38154
http://www.cypress.com/?rID=37464
http://www.cypress.com/documentation/development-kitsboards/general-psoc-programming
http://www.cypress.com/?rID=64120
http://www.cypress.com/?rID=57555
http://www.cypress.com/?rID=57555
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=107&id=1573&applicationID=0&l=0
http://www.cypress.com/?id=2522
http://www.cypress.com/?rID=35428
http://www.cypress.com/?docID=2722
http://www.cypress.com/documentation/other-resources/psoc-designer-training
http://www.cypress.com/?rID=17765
http://www.cypress.com/?rID=1085
http://www.cypress.com/?rID=1084
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=resource_meta_type%3A574&f%5b2%5d=field_related_products%3A1278
http://www1.cypress.com/?id=1573&rtID=118
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6.5 技术参考手册（TRM） 

技术参考手册（TRM）提供了 PSoC 1 器件的内部架构的详细说明。要想获取 PSoC 1 技术参考手册列表，请访问 PSoC 1

技术参考手册网页。 

6.6 器件勘误表 

这些文件列出了与器件数据手册或技术参考手册内容不符的器件规范。请访问器件勘误表网页以便获取器件勘误表文件

的列表。 

6.7 技术支持 

若有任何疑问，我们的技术支持团队很乐意为您提供帮助。您可以通过赛普拉斯技术支持连接发送支持请求。 

若果您是在美国，则可以拨打我们以下免费电话，直接与技术支持团队联系：+1-800-541-4736。在提示符处选择第 8

项。 

若想获得快速支持，您同样也可以使用下面的支持资源： 

▪ 自助 

▪ 所在地销售办事处 

 

http://www.cypress.com/
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1278&f%5b2%5d=resource_meta_type%3A583
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1278&f%5b2%5d=resource_meta_type%3A583
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1278&f%5b2%5d=resource_meta_type%3A578
https://secure.cypress.com/myaccount/?id=25&techSupport=1&source=an79953
http://www.cypress.com/support
http://www.cypress.com/?id=1062
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7 我的第一个 PSoC 1 设计 

本节介绍了使用 PSoC Designer 构建 PSoC 1，然后将其编程到 PSoC 器件并配置 PSoC 1 展示板以便查看结果的简单

设计流程。 

7.1 设计概述 

使用该设计构建一个简单项目，该项目会在两个 GPIO 上产生两个 PWM 输出（一个使用硬件资源，另一个使用软件资

源）。一个 GPIO 驱动 LED 进行固定频率闪烁，另一个 GPIO 则驱动 LED 进行心跳式的闪烁（渐亮渐灭）。该项目还

可以使用 ADC 用户模块来测量模拟电压。  

7.2 创建我的第一个 PSoC 1 设计 

7.2.1 创建项目  

首先，您可以在 PSoC Designer 中创建一个项目。在此处，您先选定器件，然后将开发语言设置为 C 语言。该示例项

目采用 CY8C29466-24PXI，因为它是附随 CY3210-PSoCEval1 套件的器件。  

1. 在 PSoC Designer 中，请选择 File（文件） > New Project（新项目）并将其命名为 AN75320，如图 6 所示。 

图 6. 创建一个新的 PSoC Designer 项目 

 

2. 点击 Device Catalog 以选择器件，如图 7 所示。 

图 7. 器件目录 

 

http://www.cypress.com/
http://www.cypress.com/?rID=2541
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注意：如果您要使用其他工具包开发此例程，则应使用以下器件型号： 

▪ CY3214-PSoCEvalUSB：CY8C24994-24LTXI 

▪ CY3271-PSoC First Touch：CY8C20634-12FDXI 

3. 点击 Create Project with ‘CY8C29466-24PXI’，然后点击 OK。 

此时，将打开项目工作区，并显示 Chip Editor 和 Workspace Explorer。按下 Ctrl 并点击以放大 Chip Editor 视图，显示

出选定器件的模块框图。  

7.2.2 选择用户模块  

在该步骤中，您可以从 User Module 目录选择所需的组件，然后对其进行配置。用户模块窗口位于右下角，如图 8 所示；

通过依次选择 View > User Module Catalog 可以显示它。 

图 8. User Module Catalog 窗口 

 

该项目使用了以下各用户模块： 

▪ 一个 ADC 用户模块 

▪ 两个 PWM8 用户模块 

▪ 一个 LCD 用户模块 

1. 要放置用户模块，请执行以下步骤：在 User Module Catalog 窗口上，展开 ADCs 文件夹。  

2. 右击 EzADC 并选择 Place。EzADC Configuration 窗口将会弹出。 

3. 在 Configuration 窗口中，选择 Double Stage Modulator 并点击 OK。（该配置将使用两个开关电容模块以获得更好

的性能。）  

4. 在 PWMs 文件夹下，右击 PWM8，然后选择 Place。  

5. 重复放置流程，将两个 PWM8 用户模块置于设计中。  

6. 从 Misc Digital 文件夹右击 LCD，然后选择 Place。 

放置好所需用的户模块后，Designer 窗口将如图 9 所显示的情况。此外，已放置的用户模块会在工作区浏览器中显示。

请注意，必须将每一个已配置的用户模块命名为 ComponentName_1，其他模块以此类推。例如，EzADC 用户模块将

被命名为 EzADC_1。 

http://www.cypress.com/
http://www.cypress.com/?rID=37815
http://www.cypress.com/?rID=17672
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图 9. EzADC 和 PWM 用户模块在芯片编辑器中的放置（数字模块） 

 

图 10. EzADC 和 PWM 用户模块在芯片编辑器中的放置（模拟模块） 

 

 

7.2.3 设置 User Module 参数   

在该步骤中，您将为放置在您设计中的用户模块进行配置参数。  

当您在工作区浏览器或芯片编辑器中点击某个用户模块时，所选用户模块的参数窗口将在左侧弹出，这样您便可以修改

参数。  

请参考框图以便设置或更改各参数。  

1. 选择 EzADC_1，然后按照表 3 中显示的内容更改它的参数。更改各参数后，该窗口将如图 11 所示。从其默认值更

改的参数将以高亮显示。  

表 3. EzADC_1 用户模块参数 

参数 值 说明 

Name（名称）  EzADC_1 指定用户模块名 

Data Format（数据格式） 无符号 将输出设置为无符号数据，因为只允许正数输入 

Resolution（分辨率） 14 位 设置 EzADC 的最大分辨率 

Sample rate（采样率） 0.007 根据分辨率设置采样率。请查看 EzADC 的用户模块数据手册。 

Input（输入） 
AnalogColumn
_InputMUX_0 

选择模拟输入数据总线，以便获得电源的输入模拟电压。 

Offset Compensation 

（补偿偏移） 
使能 使能相关双采样 

Buffer Gain（缓冲器增益） 1.000 将 PGA 增益设置为 1 以进行单位放大  

Reference（参考电压）  VSS 设置 PGA 的参考电压以执行偏移补偿 
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参数 值 说明 

AGND Output（AGND 输出） 禁用  
禁用 AGND 输出。使用该选项可生成内部 AGND，以便将双极信号连

接至 ADC 

Offset Compensation 

Frequency（偏移补偿频率） 
2 设置校正偏移所需的 ADC 采样数 

图 11. EzADC_1 用户模块参数 

 

选择 PWM8_1，然后按照表 4 所示修改其参数。更改参数后，该窗口将如图 12 所示。请注意，此时该用户模块应重新

命名为 LED1_PWM。 

表 4. LED1_PWM 用户模块参数 

参数 值 说明 

Name（名称） LED1_PWM 指定用户模块名 

Clock（时钟） VC3 将 VC3 选为时钟源。  

Enable（使能） 高 将 enable 设置为高电平，从而能够连续计数。 

Compare Out（比较输出） Row_0_Output_2 通过行输出总线将比较输出连接至 GPIO。 

Terminal Count Out（终端计数输出）  无 该参数是一个辅助计数器。您不需将其连接至任何行输出总线。 

Period（周期） 254 设置计数器的周期。 

Pulse Width（脉冲宽度） 127 设置 PWM 输出的脉冲宽度（50%占空比）。 

Compare Type（比较类型） 小于或等于 选择 Compare Type（比较类型）函数的全范围。 

Interrupt Type（中断类型） 终端计数 通过使用该选项，在计数寄存器的终端计数上触发中断。 

Clock Sync（时钟同步） 
Sync to SysClk 

（与系统时钟同步） 
将时钟输入与系统时钟同步 

Invert Enable（反转使能） 正常 该参数确定使能输入信号的意义。 
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图 12. PWM_1 用户模块参数 

 

2. 选择 PWM8_2，然后按照图 13所示的设置内容更改它的参数。请注意，此时该用户模块应重新命名为 LED2_PWM。  

图 13. PWM_2 用户模块参数 

 

3. 选择 LCD_1 用户模块，然后按照表 5 所示内容更改它的参数。更改各参数后，该窗口将如图 14 所示。 

表 5. LCD_1 用户模块参数 

参数 值 说明 

Name（名称） LCD_1 指定用户模块名 

LCD Port 

（LCD 端口） 
Port_2 该参数会使 LCD 显示模块连接至已分配的端口 

BarGraph 禁用 禁用条形图功能 

图 14. LCD 参数 
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4. 从 View > Global Resources 打开 Global Resources 窗口，配置 PWM 时钟频率的源时钟以及 ADC 输入数据范围

的 Ref Mux。保留其他参数为其默认值。更改后，Global Resources 窗口将如图 15 所示。更多有关全局资源的信

息，请查看 IDE 用户指南。 

图 15. 全局资源参数 

 

7.3 路由 PWM 信号  

在该选项中，用户将 PWM 信号从 PWM 用户模块路由到所选的 GPIO。 要查看 GPIO 引脚上的信号，则必须实现 PWM

信号的路由。 

此外，该设计还对两个 PWM 输出进行 XOR 运算，从而实现行输出中的逻辑。两个 PWM 信号周期之差经过异或（XOR）

运算后，将形成脉冲式（心跳式）效果。  

1. 将 LED1_PWM 的 CompareOut 连接至 Row_0_Output_2。 

2. 将 LED2_PWM 的 CompareOut 连接至 Row_0_Output_3。  

3. 通过使用自动路由功能将 LED1_PWM 的 CompareOut 连接到 Port_1_2。按下 Shift 键并选择 LED1_PWM 的

CompareOut 引脚，然后将其连接至 Port_1_2，如图 16 所示。您也可以使用 GlobleOutOdd_2 手动将 LED1_PWM

连接到 Port_1_2  

图 16. PWM 与行输出总线相连 
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4. 点击 Row_0_Output_2 数字互连以打开配置选项，如图 17 所示。 

图 17. RO0[2]数字互连视图 

 

5. 点击 LogicTable_Select，然后从下拉列表中选择 A_XOR_B（如图 18 所示），然后点击 Close。 

图 18. 数字互连配置 

 

6. 请确保数字路由图和图 19 所示的一样。如果两图匹配，则您已完成了脉冲心跳式 LED。 

图 19. Designer Chip 视图 

 

7.4 添加代码 

在该步骤中，用户需要添加代码来配置所有用户模块和 GPIO，从而实现一个由软件控制其闪烁的 LED。将随后的自定

义代码添加到项目中的 main.c 文件。  

1. 在 Workspace Explorer 中，在 AN75320 文件夹下面寻找 Source Files 文件夹并打开 main.c 文件。  

2. 复制以下列出的 C 代码并将其粘贴到 main.c 文件中，代替已存代码。 

代码 1：项目 1 的 main.c 

/* part specific constants and macros */ 

#include <m8c.h>         

 

/* PSoC API definitions for all User Modules */ 

#include "PSoCAPI.h"     

 

/* Definitions for all input and output operation */ 

#include "stdio.h" 

 

 

http://www.cypress.com/


 

PSoC® 1入门 

www.cypress.com 文档编号：001-78863 版本*G 20 

/* Macros to set ADC parameters */ 

#define GAIN   1 

#define MAX_ADC_COUNTS 16383 

#define ADC_RANGE  5000 

 

/* Macros to select port 1 */ 

#define PORT_1_3        PRT1DR 

 

/* Variable to store the ADC result */ 

WORD adc_result;    

 

/* Variable to store the measured input in millivolts */ 

WORD v_in;     

void main(void) 

{ 

    static unsigned int index; 

  

/* Buffer used for the long to ASCII conversion */ 

char LCDBuffer[17];  

 

/* Initializes LCD to use the multi-line 4-bit interface  */ 

LCD_1_Start(); 

 

/* Enable global interrupts */ 

M8C_EnableGInt ;  

 

/* Set the position to print the character */ 

LCD_1_Position(0,0);  

 

/* print the Hello World in the first line */ 

LCD_1_PrCString("Hello World!"); 

 

/* Starts the LED1_PWM and LED2_PWM, high enable input begins the Counter */ 

LED1_PWM_Start();  

LED2_PWM_Start(); 

 

/* Initializes and starts the EzADC User Module resources */ 

EzADC_1_Start(EzADC_1_HIGHPOWER);  

 

/* Starts the ADC conversion */ 

EzADC_1_GetSamples(0);  

   while(1) 

 { 

    /* Wait for the ADC result to be available */ 

    while(!(EzADC_1_fIsDataAvailable()));  

     

    /* Read the ADC result and clear the data ready flag */ 

    adc_result = EzADC_1_iGetDataClearFlag();  

     

    /* Calculate input voltage in mV */ 

    v_in = (DWORD)adc_result*ADC_RANGE / MAX_ADC_COUNTS / GAIN;  

     

    /* Convert the input voltage to an ascii string */ 

    csprintf(LCDBuffer, "ADC INPUT:%4dmV", v_in); 

     

    /* Set the position to print the character */ 

    LCD_1_Position(1,0);  

     

    /* print the voltage in the second line */ 

    LCD_1_PrString(LCDBuffer); 
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    /* Toggle the pin 1[3]*/ 

    PORT_1_3 ^= 0x08;  

     

    /* Give some delay to view toggling effect*/ 

        for(index = 0; index < 22000; index++);  

   } 

} 

 
3. 添加该项目附带的 local.mk 文件以便使能 ADC 浮点功能。更多有关该函数的信息，请查看 local.mk 文件。  

 

7.5 配置引脚分布 

在该步骤中，用户要将引脚配置为 GPIO 驱动模式，从而能够驱动 LED。从 Pinout 视图中，配置所选器件的引脚分布。

（View > Pinout。Pinout 屏幕将显示在工作区的左下方。 

1. 在 Pinout 视图上，展开 P0[1]、P0[5]、P1[2]和 P1[3]。按照图 20 配置各引脚。 

图 20. 引脚配置 

 

7.6 构建和编程 

在该步骤中，请将 MiniProg1 器件连接到您的电脑上，并使用构建项目编程 PSoC 器件。  

1. 选择 Build > Generate/Build ‘AN75320’ Project 或按下 F6 按键。（请查看图 21）。 
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图 21. 构建与生成选项 

 

 

2. 输出窗口应显示构建状态，包括 RAM/闪存使用情况以及错误和警告的数量，如图 22 所示。 

图 22. Output 窗口 

 

3. 将 MiniProg1/MiniProg 3 连接至您的电脑。  

4. 将 MiniProg1/MiniProg3 连接到电路板的编程插座。有关详细信息，请参阅设置 CY3210-PSoCEval1 电路板。 

5. 选择 Program > Program Part（如图 23 所示）。Program Part 窗口将如图 24 所示。 

图 23. 编程器件选项 

 

6. 在 Program Part 窗口上，请执行以下各操作： 

a) 点击 Connect 按键（Port Selection 字段旁边），连接至器件。 

b) 如果 MiniProg 给器件供电，Acquire Mode（获取模式）将被设置为 Power Cycle（电源循环），通过循

环电源，MiniProg 可以获取器件。这是默认选项。对于该项目，请使用该默认选项。 

c) 如果器件通过外部供电并且 MiniProg 只能通过复位获取器件，那么将 Acquire Mode 设置为 Reset。 
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7. 点击 Program 按键以便编程器件，如图 24 所示。 

图 24. 编程状态 

 

8. 当编程完成时，按下 Power 按键，对器件进行切换。现在，编程器给电路板供电。观察一个 LED 闪烁和另一个 LED

淡入和淡出。  

7.7 设置 CY3210-PSoCEval1 电路板 

本演示与 CY3210-PSoCEval1 硬件兼容。更多有关该套件的信息，请访问地址

http://www.cypress.com/documentation/development-kitsboards/cy3210-psoceval1。 

图 25. CY3210-PSoCEval1 套件视图 
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按以下步骤对CY3210-PSoCEval1套件进行配置和编程。请注意，该套件需要使用编程器件，例如MiniProg或 ICE-Cube。 

1. 演示板上未连接线缆时，请确保未接通 J1、J2 和 J3。  

2. 一根导线将 P0[1]连接至 VR，将 P1[2]连接至 LED1， 用另一根导线将 P1[3]连接至 LED2（如图 26 所示）。 

图 26. CY3210-PSoCEval1 引脚连接 

 

3. 确保电路板上的当前器件为 CY8C29466-24PXI。 

4. 要想供电给电路板，请将 MiniProg1/MiniProg3 连接到电路板的编程插座（J11）。或者，将 12 V 直流电源连接到

套件上的 J10。也可以将一节 9 V 电池与 J12 相连。此外，还需将一个编程器件连接至 J11。使用外部电源或电池

时，请使用复位编程模式。电路板连接情况如图 27 所示。 

图 27. 电源与程序连接 

 

  

http://www.cypress.com/
http://www.cypress.com/?rID=2541


 

PSoC® 1入门 

www.cypress.com 文档编号：001-78863 版本*G 25 

7.8 设置 CY8CKIT-001 电路板 

在使用 CY8C29x66 处理器模块时，本演示可与 CY8CKIT-001 硬件兼容。有关该套件的更多信息，请访问 

http://www.cypress.com/?rID=37464 网站。 

按以下步骤对 CY8CKIT-001 套件进行配置和编程。请注意，该套件需要使用编程器件，例如 MiniProg 或 ICE-Cube。

此外，使用 ICE-Cube 时，该套件支持片上调试。  

图 28. CY8CKIT-001 套件视图 

 

1. 在演示板未连接线缆的情况下，按表 6 所示设置以下跳线器，以配置开发板： 

表 6. 跳线器设置 

跳线器 设置 

VDD 选择（SW3）  5 V（上方位置） 

5 V 源（J8）  VREG（上方两个引脚） 

VDD 数字（J7）  VDD（上方两个引脚） 

VDD 模拟（J6）  VDD（上方两个引脚） 

LCD 电源（J12）  ON（下方两个引脚） 

VDDIO 选择（J2-J5）  VDD（上左方两个引脚） 

 
2. 一根导线将 P0[1]连接至 VR，将 P1[2]连接至 LED1， 用另一根导线将 P1[3]连接至 LED2（如图 29 所示）。 
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图 29. 引脚连接图 

 

3. 将 MiniProg 或 ICE 等编程器件连接至 PSoC 1 处理器模块上的 J5。  

4. 之后，通过使用编程器的电源或 12 V 直流电源或一节 9 V 电池，将电源连接至电路板。使用外部电源或电池时，请

确保使用复位编程模式。查看图 30 以便了解电路板上的连接情况。 

图 30. 电源与程序连接 
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无论使用哪套开发套件来测试应用，您都会看到： 

1. LCD 显示“Hello World”和“ADC INPUT:----mV”  

2. 一个 LED 快速闪烁。 

3. 另一个 LED 闪烁速度则非常缓慢，亮度逐渐增加和减弱。 

8 总结  

本应用笔记展示了 PSoC 1 架构以及开发套件。本应用笔记描述了启动 PSoC 1 项目所需的工具。PSoC 1 是一个真正

的可编程嵌入式片上系统，它在单芯片上集成了可配置的模拟和数字外设功能、存储器和 M8C 微控制器。  

此外，本应用笔记还向您提供了全部资源列表，用以加快深入学习有关 PSoC 1 的知识。 

有关其中所涉任何主题的更多信息，请参阅相应的链接或参考，也可以访问 http://www.cypress.com/products/psoc-1。 

9 相关应用笔记 

该应用笔记介绍了 PSoC 1 的基本信息。有关更多信息和特殊主题的相关项目，请参考应用笔记中介绍的内容。 

▪ 入门  

 AN54181 — PSoC 3 入门 

 AN79953 — PSoC 4 入门 

 AN77759 — PSoC 5LP 入门 

▪ 模拟模块 

 AN2219 — PSoC® 1 选择模拟接地和参考 

 AN74170 — PSoC 1 模拟结构和通过 PSoC DesignerTM进行的配置 

 AN13666 — 将 PSoC® 1 模拟缓冲输出驱动至轨 

 AN2096 — PSoC® 1 — 使用 ADCINC 模数转换器 

▪ 开关式电容模块 

 AN2041 — 了解 PSoC 1 开关式电容模拟模块  

 AN2168 — PSoC 1 了解开关式电容滤波器 

 AN16833 — 使用 PSoC®开关式电容模块进行信号复用 

▪ GPIO 

 AN2094 — PSoC® 1 — GPIO 入门 

▪ 编程 

 AN44168 — 使用外部微控制器（HSSP）的 PSoC® 1 器件编程。 

▪ 数字模块 

 AN2141 — PSoC® 1 脉冲自由 PWM 

▪ 闪存 

 AN2015 — PSoC 1 读取和写入闪存以及 E2PROM 

▪ I2C 

 AN50987 — PSoC 1 I2C 入门 

▪ SPI 

 AN51234 — PSoC® 1 SPI 入门 

▪ 睡眠模式 

 AN47310 — 使用睡眠模式节省 PSoC® 1 功耗 

http://www.cypress.com/
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▪ LCD  

 AN56384 — PSoC® 1 Segment LCD 直接驱动 

 AN2152 — PSoC® 1 图形 LCD 和 PSoC®接口 
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全球销售和设计支持 

赛普拉斯公司拥有一个由办事处、解决方案中心、厂商代表和经销商组成的全球性网络。要想查找离您最近的办事处，请访问赛

普拉斯所在地。 

 

产品 

Arm® Cortex®微控制器 cypress.com/arm 

汽车级产品 cypress.com/automotive 

时钟与缓冲器 cypress.com/clocks 

接口 cypress.com/interface 

物联网 cypress.com/iot 

存储器  cypress.com/memory 

微控制器 cypress.com/mcu 
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